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 Installation

Introduction
This topic guides you through installing (or upgrading) and activating Wirecast One.

Topics
 Installing

 Uninstalling

 System Requirements

Installing
To install Wirecast One, follow these steps:

1. Download the installer from the Website at:  http://www.telestream.net/Wirecast/
overview.htm.

2. Run the installer (.exe) program and follow the instructions provided

Note: During installation, you will be asked if you want to install the Virtual 
Microphone feature. If you do (recommended), check the displayed check box and 
continue the installation. Installing Virtual Microphone requires administrative rights.

3. If you have an older version of Wirecast One already installed on your computer, the 
installer upgrades to the newer version. Agree to the license terms and follow the 
instructions displayed by the installer program.

http://www.telestream.net/wire-cast/overview.htm
http://www.telestream.net/wire-cast/overview.htm
http://www.telestream.net/wire-cast/overview.htm
http://www.telestream.net/wire-cast/overview.htm
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Activating
When you purchased WirecastOne a serial number was provided. This serial number 
must be registered in the WirecastOne program to unlock the features of WirecastOne. 
To register WirecastOne follow these steps:

1. Run the WirecastOne program.

2. Select Preferences from the File menu, select Licenses, then click Purchase. Once you 
purchase and obtain your license number, enter it into the Serial Number field and 
click Activate.

   

3. Close the Preferences window.

Your WirecastOne program should now be fully activated.

Uninstalling
To uninstall WirecastOne, follow these steps:

1. Run the WirecastOne installer (.exe) program. 

2. The installer asks if you want to repair or remove the existing version. Select 
Remove to uninstall the existing version of WirecastOne.

System Requirements
Operating System

• Minimum: Windows 7

• Recommended: Windows 10

Processor   

• Minimum: i5 dual-core @ 2.3GHz
NOTE: May be insufficient for 1080p+ or 60 fps workflows

Select Licenses

Click Activate

Click Purchase

Enter serial 
number
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• Recommended: i7 quad-core @ 2.8GHz+

Memory   

• Minimum: 4GB RAM   

• Recommended: 16GB+ RAM

Hard Drive   

• Minimum: 2GB, 7200 RPM for record to disk   
NOTE: Additional hard disk space required for record to disk

• Recommended: 500GB+, Solid State OS Drive

Graphics Card   

• Minimum: Intel HD, DirectX 11 capable    
NOTE: Insufficient for advanced Multi-Viewer workflows

• Recommended: Nvidia GeForce or AMD Radeon, 1GB+ video memory

Internet Connectivity    

• Minimum: Open HTTP/HTTPS port 80, RTMP port 1935, 
port 7272 for Remote Desktop Presenter

• Recommended: If behind a firewall, check with your CDN for any sites to whitelist

Note: You are strongly advised to run WirecastOne using the Windows Aero Theme, 
which includes a hardware accelerated window manager. Problems may result if you 
use the Windows Classic Theme.

Internet Connectivity

• Requires internet connectivity with HTTP/HTTPS port 80, and RTMP port 1935 open 
for streaming.

• For lowest quality (240p) streaming an upload rate of at least 650Kbps is required.

• 720p streaming requires an upload rate of at least 2500 Kbps.

• 1080p streaming requires an upload rate of at least 4500 Kbps.

• Consider lowering your canvas frame rate and/or streaming resolution to lower 
CPU usage.

• It is recommended that an upload rate of at least double the desired rate be avail-
able.

Recommended Hardware Specifications

• Intel HD, NVIDIA GeForce, or AMD Radeon class graphics adapter that is DirectX 11 
capable.

• Minimum 4GB RAM, 2GB free hard disk space. Additional hard disk space required 
for recording to disk. 

Hardware Accelerated Encoding Requirements
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• Intel Quick Sync Video encoding requires an Intel CPU with an Intel® QuickSync 
Video core. List of Intel CPUs supporting QuickSync.

NVIDIA NVENC encoding requires an nvidia GPU with Kepler architecture or newer. 
NVIDIA only maintains a general list of supported GPUs.
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Tutorials

Introduction
The best way to get started using Wirecast One is to quickly work through all its main 
features. This tour presents a series of three tutorials, each designed to help you 
understand how to create and stream presentations using Wirecast One. 

As you work through these tutorials, you will also become familiar with important 
Wirecast One concepts and how you can use them to deliver high quality broadcasts. 
The more you know about Wirecast One, the better it will serve your streaming 
objectives.

Because each tutorial builds on the skills and knowledge you learn in the previous 
tutorials, it is recommended that you take the tutorials in succession. Working through 
all the tutorials takes about thirty minutes.

As you gain hands-on experience creating video and audio presentations - which leads 
to a working knowledge of Wirecast One and its components and architecture - you 
will gain proficiency in using Wirecast One.

Tutorials
 Tutorial 1: Basic Concepts

 Tutorial 2: Editing Shots

 Tutorial 3: Broadcasting

Note: You can run all of the tutorials without a license. However, a watermark on the 
video and an occasional voice-over on the audio are present until a valid license is 
activated. 

Note: For licensing information, select Preferences from the File menu, select License, 
then click Purchase. Or, you can contact Telestream at: desktopsales@telestream.net.
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Tutorial 1: Basic Concepts
The goal of this tutorial is to provide you with a quick but successful experience 
creating and streaming a presentation using Wirecast One. 

This tutorial requires that you open the tutorial document in Wirecast One. To do this, 
select Create Document for Tutorial from the Help menu in Wirecast One. 

Note: If you are running the tutorial with Wirecast One in demonstration mode, the 
Wirecast One logo appears from time to time and audio output has a periodic voice-
over.
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Tutorial Prep
To prepare for this tutorial you need to make several changes. Under the Switch menu, 
make sure Smooth and AutoLive options are turned on (check mark displayed), and 
Live/Preview Swap is turned off (no check mark displayed).

Under the Layout menu, make sure Show Live Only is selected (check mark displayed). 

All of these options will be changed later in the tutorial. 

The Wirecast One Main window shows the AutoLive LED turned on and the Live 
Broadcast window (only) displayed.

Live Broadcast window displayed

AutoLive LED on
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The Main Window
Wirecast One has two main display areas: Live Broadcast area and the Shot List. The Live 
Broadcast area is in the upper portion of the window displaying what Wirecast One 
streams to your viewers (or what it records to disk). The Shot List, in the lower half of the 
window, displays the shots available for streaming.

What Is a Shot?
Wirecast One uses the concept of a “shot” to construct presentations. A shot contains 
some form of media (pictures, video, etc.), along with any settings for that media. In its 
simplest form, a shot contains one piece of media such as a photo or a video clip. But it 
can also be something more complex, like a live camera with a title and background 
music. Or a shot can even be something even more complex like a Playlist of shots.

A shot can be edited and its settings can be changed (See Tutorial 2: Editing Shots). 
Shots are important because they enable you to configure a lot of information before 
you stream your presentation. This enables you to concentrate on creating a good 
production during your broadcast. 

Live Broadcast Area

Shot List
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Switching Between Shots
Individual shots are displayed in the Shot List. Click the Ripples shot in the Shot List area 
and the image fades into the Live Broadcast Area display. This is called “taking a shot 
live”. 

Shot in Live Broadcast Area

Click Ripples shot
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Click the shot labeled Clear Layer and the Ripples image fades to a blank screen. The 
Clear Layer shot enables you to display a blank shot, which is sometimes needed. 

Transitions
In the previous examples, a “fade action” occurred when you clicked on a shot. This is 
because the smooth transition is the default. 

Note: Wirecast One does not support a true Dissolve transition. The Smooth transition 
is the closest choice for dissolve. The main difference is that when Smooth is used in 
transitions that involve position or size changes in the images, the smooth transition 
migrates from one image to the other rather than dissolving out of one and into the 
other. 

If you are transitioning from an “A to A” shot (a shot that contains a “picture in picture” 
effect, or a “side-by-side” shot) then Smooth will interpolate the difference between 
the shot elements’ position and size and will smoothly animate the changes. This will 
make a shot element bigger or smaller and move it on the screen as needed. However, 
if you are transitioning from an “A to B” shot (from one shot to an entirely different 
shot), then the Smooth transition will act like a traditional Dissolve and fade between 
the two images.

Blank shot in Live Broadcast Area

Click Clear Layer
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Transition controls are located just below the Live Broadcast Area where the two 
default transitions are shown: Cut and Smooth.

When Cut is selected, transitions are executed immediately. When Smooth is selected, 
transitions fade in and out (as demonstrated above).

But there are more than just two kinds of transitions, and only two transitions can be 
assigned to the Transition Panel. To select a different transition, click the small arrow on 
the right side of either transition button. When the list appears, select a new transition 
to be assigned to that button. You can also click the transition button itself and drag the 
mouse downward until the menu of selections is displayed.

        

For example, to change the left transition button from Cut to Bands, click the Cut 
button and drag downward until the menu appears. Select Bands from the menu. 
Bands should now be displayed as the left button. 

Click arrow to open menu

Select a 
transition

new Bands button
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Now click back and forth between the River and Ripples shots using Bands (Bands 
button selected).

These two transition buttons can also be selected by using the following key 
combinations: Ctrl+1 and Ctrl+2. 

Transition Speed 
You can also control how fast a transition occurs, by selecting Switch >Transition Speed. 
Your choices range from Slowest to Fastest.

Go Button 
The Go Button (or Ctrl+G) enables you to make a transition.

 Bands transition

Go button
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Clicking the Go button does nothing when Wirecast One is in AutoLive mode. The only 
exception is that it will update a live shot if you have made changes to it using the Shot 
Editor. Later in this tutorial you will discover how to use the Go button to transition 
between different shots when AutoLive is off.

Layers 

Note: Before you start this section, please select Smooth as your transition.

Wirecast One enables you display several shots in the Preview and Live windows at the 
same time by rendering them one on top of another according to Wirecast One's Layer 
system. This is an excellent way to add and remove objects in your broadcast. 

Wirecast One displays five layers in the Main Shot List window. They are numbered 1 
through 3 along the right side of the window. Each layer contains shots that can be 
selected by clicking a shot. A red LED indicates that a shot is selected. When a shot is 
selected it is displayed in the Live Broadcast window. If you select multiple shots (by 
selecting a shot on more than one layer) they will all be displayed in the Live Broadcast 
window. The shots are displayed in a layering manner, where layer 1 is on top and layer 
3 is at the bottom (and layer 2 in between). 
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Select the Logo shot in layer 2 and the River shot in layer 3. The result is a layered shot 
containing both images.

Layers are displayed in a particular order: Layer 1 is on top, Layer 2 below it, Layer 3 
below Layer 2, etc. This tutorial, so far, has been operating on Layers 2 and 3. Clear 
Layer, Ripples, River shots (and more) are on Layer 3, but Layer 2 has only a logo and a 
Clear Layer shot.

    

Layer numbersSelect River 
shot

Layered shot 

Select Logo 
shot
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Each layer can be turned on or off by clicking the white LED light on the far right side of 
the layer window. Click the Layer 2 LED to remove the Logo shot. 

Click the LED again to turn Layer 2 back on and restore the Logo image.

Auto Live 
So far in this Tutorial, Wirecast One has been running in AutoLive mode. This means 
that any selection you make in the Shot List is automatically placed into your Live 
Broadcast window. This mode is very useful for those users who want to set up all of 
their shots at once and then single-click them as they run their presentation. But the 
disadvantage of this single-click method is that you can only see one shot change at a 
time. Once you click a shot, your viewers also see it (with no preview for you of how it 
looks before broadcasting the new shot). 

Turn AutoLive Off 
An red LED, next to the Go button is lit when you are in AutoLive mode.

Click white dot to 
turn Layer 2 off

Logo removed

AutoLive LED
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For this tutorial, make sure AutoLive is off by un-checking AutoLive in the Switch menu. 
When you do this a dialog box is displayed informing you that AutoLive is off and 
transitions must be made using the Go button. Click OK in the dialog box to continue. 

Try clicking the Ripples and River shots, and notice that nothing happens in the Live 
Broadcast window because AutoLive is turned off. Now click the Ripples shot and then 
click the Go Button. The Ripples shot is immediately placed into the Live Broadcast 
window. Click the River shot and, as expected, nothing happens. Click the Go button  
and the River shot replaces the Ripples shot in the Live Broadcast window. 

Note: When AutoLive is off, you must always click the Go button (or press the Ctrl+G 
keys) to display the selected shot in the Live Broadcast Area. 

Multiple Changes
The benefit of having AutoLive off is that you can make several changes to your shot 
first, and then have all changes placed into the Live Broadcast window at the same 
time. To do this, first verify that AutoLive is off. Click Sample Title in layer 1, click Clear 
Layer Shot in Layer 2, and then click the Ripples Shot in Layer 3. Click the Go button (or 
Ctrl+G) to make the Ripples and Sample Title shots live at the same time.

Select Sample 
Title shot

Select Ripples 
shot

Layered shotsClick Go buttonSelect Clear 
Layer shot
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Preview 
One problem you may have noticed while running this tutorial is that you cannot see 
the changes you are making before broadcasting them. To solve this problem, Wirecast 
One enables you to see a preview of what you broadcast. 

Select Layout > Show Live and Preview from the Main menu. A preview window is 
displayed to the left of the Live Broadcast window. The Preview window uses a green 
LED to identify it. The Live Broadcast window uses a red LED to identify it. These two 
colors (green and red) are also used to identify which shots are associated with the 
Preview or Live windows.

      

Green LED Red LED
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Click the River shot on Layer 3. The River shot is displayed in the Preview window. When 
shots are selected they display a green or red LED to indicate selection for Preview or 
Live windows.

    

Preview window Live window

Red LED (Live window)
Green LED (Preview window)
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Now click the Go button to place the River shot into the Live window. Click the Clear 
Layer shot in Layer 1 to remove the title from the River shot in the Preview window.

       

Turn on the Live/Preview Swap option by selecting Switch > Live/Preview Swap (check 
mark displayed). Notice that the Go Button displays a double-arrow, indicating that the 
Live/Preview Swap option is on.  

Select the Ripples shot and click the Go button to place the Ripples Shot into the Live 
window. Notice that the Ripples and River shots have swapped (between Preview and 
Live windows). The shot LED’s have also changed color.  The green shot LEDs indicate all 
shots included in the Preview window and the red LEDs indicate the shots included in 

Click Clear Layer Shot Click Go button

Preview shot became Live shot

Double-arrow
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the Live window. This lets you know what your last Live window looked like as you 
prepare your next shot in the Preview window.

      

Red LEDs show Live window shots

Ripples and River shots swapped

Green LEDs show Preview window shots
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Tutorial 2: Editing Shots
The first tutorial used only the Main window, and explained various ways in which you 
can use an existing shot. But shots can also be created and edited. This tutorial 
demonstrates how to edit your shots.

To edit a shot, double-click its icon in the Shot List. This opens the Shot Editor panel.

Double-click 
a shot

Shot Editor panel
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The shot editor has six tabs: Shot Layers, Shot Layer Properties, Audio, Chroma Key 
Properties, Smooth Transition Properties, and Additional Properties.

   

Shot Properties Enables you to add and delete sources and change the display order 
(change layering within the shot).

Shot Layer Properties Enables you to change the size, position, and other properties 
of a shot source.

Audio Properties Enables you to set audio levels and other controls. You can also 
monitor audio levels. 

Chroma Key Properties If a source in your shot uses a chroma key, this tab enables you 
to configure the chroma key settings. Each source in a shot can have its own chroma 
key settings.

Additional Properties Enables you to set any additional properties for a source in your 
shot: System Device properties, Screen Display properties, Twitch Widgets (Chat and 
Followers), etc.

See Shot Editor for details on how to use the Shot Editor.

Shot Layers tab

Chroma Key Properties tab

Smooth Transition Properties tab

Shot Layer Properties tab

Audio tab

Additional Properties tab
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Tutorial 3: Broadcasting
This tutorial demonstrates how to setup and broadcast your Wirecast One 
presentations. 

You need to decide how you are going to encode your broadcast. Encoding is the type 
of compression used. Wirecast One comes configured with many common encoding 
options.  (Dee The Encoder Presets Window for details.). 

Streaming
Click the Stream button to start streaming.

        

The Stream icon will blink until a connection is made. Once you are connected the 
Stream icon turns green. If you cannot connect an error message will display. 

        

Connection strength is indicated by how many bars are displayed in the Stream icon. 
Fewer bars indicates a weaker (slower) connection.

        

If the connection is ever broken, a no connection icon is displayed in place of the bars.

        

When the connection recovered, the no connection icon is replaced with the green bars.

Click the Stream button

Green Stream icon

Green connection 
strength bars

No connection icon
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Click Stream again to stop streaming. You can also record your broadcast by clicking 
Record. When you stop streaming, if you. 

        

While streaming, status is displayed.

       

If you are streaming to Facebook, additional status is displayed on the right side of the 
status bar.

         

If you are streaming via the Cloud, additional status is displayed on the right side of the 
status bar.

         

Telestream Cloud Settings

Note: Cloud-based streaming and distribution is available in Wirecast One for an 
additional monthly subscription.  Visit the Telestream website for more information.

The Telestream Cloud enables you to add automated live captioning to your broadcast. 
But it also allows you to do “re-streaming” (multi-distribution of your broadcast 
through the Cloud).

When you request automated captioning, the Cloud server will send out the audio 
portion of your broadcast for translation into text. When the text is received, it is 
embedded as 608/708 captions in the outgoing stream.

Stre aming 
time

Recording 
time

CPU usage

Frame rate
Streaming rate

Various 
reactions

Number of 
viewers

Cloud icon Cloud status
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When you request stream redistribution, the Cloud takes your single stream source 
received from Wirecast and distributes it to multiple endpoints in a high bandwidth 
environment.

Cloud settings are accessed on the Output Settings window (Output > Output Settings). 
Click Telestream Cloud Settings to open the Cloud Settings window.

If you are not already Logged In to the Cloud, a Welcome window will display.  Log in by 
clicking Log In.  If you are not Signed Up with Telestream Cloud, you can do so by 
clicking Sign up.

Click to open Settings window

Click to open Settings window

Click Sign Up or Log In
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If you click Sign Up, a sign up window will display.  Enter all requested information and 
click Sign Up.

When the Activate Account window displays, wait until you receive your Activation 
Code via phone call or text.  Enter the activation code and click Activate my account.  If 

Enter information

Click Sign Up
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you do not receive an activation code, or if the code does not work, request a new one 
by clicking Resend Code.

Once you are logged in, clicking the Telestream Cloud Settings button will open the 
Cloud Settings window. 

For captioning, select a language. You can, optionally, enable live captioning.  

Note: When you check this option, all of your streaming destinations via the Cloud 
will include automatic live captions. 

For re-streaming, select Encoding for all destinations that are re-streamed via the 
Cloud. Click the Get More or the Manage Account button to navigate to the Telestream 
Cloud Dashboard. 

When you are ready to select multiple streaming destinations to be used by the Cloud, 
open the Output Settings window (Output > Output Settings) and select multiple 
streaming destinations by clicking the Add button. Check Enable for all destinations to 

Click Activate

Enter activation 
code received

Click Manage account

Check Enable Live Captions

Select a language
Click Get More (optionally)

Select Encoding

Click Log Out
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be included in the Cloud streaming distribution. Click Telestream Cloud Settings to open 
the Cloud Settings window.

Note: When Enable is checked, Encoding is grayed-out.  This is because encoding for 
all distributed streams is set on the Cloud Settings page.

Click Add Check Enable

Click Telestream Cloud Settings 
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